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0. Preface

About this documentation

The documentation for SoftWindows for UNIX is provided in two guides:

• This SoftWindows 95 for UNIX User’s Guide provides the information you need to use
SoftWindows on your UNIX workstation.

• A separate SoftWindows 95 for UNIX Administrator’s Guide describes how to install
SoftWindows, and configure it to take advantage of specific features of your UNIX
installation. It is designed for use by advanced users, and assumes familiarity with
UNIX.

• An on-line version of each of these guides is available from the SoftWindows Help
menu, and HTML versions are installed in the $SWINHOME/turbo directory.

About this guide

This guide consists of the following sections:

Chapter 1, “Introduction,” describes the main features of SoftWindows and explains
how it enables you to run PC applications on your UNIX workstation.

Chapter 2, “Using SoftWindows,” explains how to run SoftWindows, describes the key
features of the SoftWindows window, and explains how to use floppy disks and the
keyboard with SoftWindows.

Chapter 3, “Using Windows 95,” explains how to run Windows 95, and gives a brief
introduction to its features with a simple tutorial to help you become familiar with
using it.

Chapter 4, “Using MS-DOS,” explains how to run MS-DOS, use MS-DOS commands, use
the MS-DOS editor, and install and run MS-DOS applications.
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Chapter 5, “Using SoftWindows with the Internet,” explains how to run Internet
Explorer, and shows how to use it to access up-to-the-minute technical support.

Chapter 6, “Troubleshooting,” provides answers to commonly asked questions and
suggests solutions to the problems that you may encounter while running PC
applications on your UNIX workstation. It also gives explanations of the SoftWindows,
MS-DOS, and Windows errors.

Conventions

For clarity, this guide uses the following typographical conventions:

This guide uses the following abbreviations:

Table i Typographic Conventions

This style Refers to this

COMPUTER Anything you type, exactly as it appears on the screen

bold Names of menus, menu commands, buttons, dialog boxes, and
windows that appear on the screen

E, c Special keys on the keyboard

R The Return key, also sometimes labeled Enter

m The SPARC workstation Meta key, sometimes labeled with a
diamond

italics References to other sections in this guide

Table ii Abbreviations

This abbreviation Refers to this

SoftWindows SoftWindows 95 version 5 for UNIX workstations

MS-DOS Microsoft Disk Operating System for the IBM PC

PC An Intel-based computer

Windows Microsoft Windows 95
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Chapter 1

1. Introduction

This chapter describes the main features of SoftWindows, and explains how it enables
you to run PC applications on your UNIX workstation.

What is SoftWindows?

SoftWindows is a complete IBM-compatible PC in software. It allows you to run
Windows and MS-DOS applications on your UNIX workstation as if they were running
on a PC.

It combines full PC compatibility with fast performance and built-in networking, so, for
example, you can receive electronic mail, read PC-formatted CD-ROMs, and print
PC files to a network printer, all from your UNIX workstation.

SoftWindows: a cross-platform solution

SoftWindows is available for the leading RISC-based UNIX workstations from
Hewlett-Packard, Sun/SPARC, IBM, and Silicon Graphics, as well as Apple’s Power
Macintosh computers.

SoftWindows provides integrated access to information throughout an organization by
letting PC users and UNIX users share the same data and applications. From one
workstation users can run native UNIX applications, Windows and MS-DOS
applications, and also use PC-based networked systems.

SoftWindows allows you to standardize on today’s popular productivity applications,
such as Microsoft Office and Lotus SmartSuite on PC, UNIX, and Macintosh platforms,
throughout the organization.
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Pentium processor emulation

SoftWindows provides full emulation of the Intel Pentium processor, enabling you to
exploit the full functionality of current PC software.

Among the features provided by this emulation are:

• The ability to run Windows 95

• Continued support for OLE 2.0

• Multiple MS-DOS sessions

• 32-bit memory addressing

• Support for virtual device drivers

The Windows 95 desktop

SoftWindows includes color and monochrome Windows display drivers to optimize the
performance of Windows 95 and allow it to be run in a window of any size on either color
or monochrome displays. The Windows desktop can be resized dynamically, without
restarting.

You can switch between a PC application and another UNIX application at any time. You
can copy and paste text or graphics between PC and UNIX applications. Text or graphics
can be cut or copied from Windows applications, and is automatically converted into the
appropriate format when you paste it into a UNIX application.
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Figure 1-1 The Windows 95 Desktop

Windows 95 TurboStart

A unique TurboStart™ feature lets you quit from SoftWindows without exiting
Windows 95. Windows loads instantly the next time you run SoftWindows, and you can
resume where you left off.



4

Chapter 1: Introduction

The SoftWindows MS-DOS window

When running MS-DOS SoftWindows emulates the VESA 2.0 standard SVGA (Super
Video Graphics Array) PC display type.

Indicators in a status bar at the bottom of the SoftWindows window show you whether
special keyboard modes or certain configuration options are selected.

The SoftWindows menus

The SoftWindows menus allow you to configure SoftWindows to suit your PC
applications. Many operations that would require hardware or board changes on a real
PC can be carried out simply by choosing the appropriate function from one of the
SoftWindows menus.

On-line help

SoftWindows includes context-sensitive on-line help.

The on-line help is available at all times, even prior to installation and when
SoftWindows is not running. Help is displayed in a separate Motif window and operates
in the same way as Windows help.

The SoftWindows printed documentation and on-line help system are structured to
support both system administrators and users. All installation and configuration
information, as well as licensing and networking information, is incorporated into a
printed SoftWindows 95 for UNIX Administrator’s Guide and comprehensive on-line help
file. Information on using the product is contained in this SoftWindows 95 for UNIX User’s
Guide and on-line help file.
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Product specification

SoftWindows emulates a PC to provide the following features:

Processor

Emulated Pentium MMX.

Memory

PC memory up to 255 Mbytes.

Video

In Windows 95 applications, a SoftWindows display driver is used to pass graphics calls
directly to X Windows. This takes full advantage of the host graphics speed and display
resolution, up to and beyond resolutions achievable with SVGA graphics. In MS-DOS
applications SoftWindows provides SVGA graphics.

Keyboard

The host keyboard is used. SoftWindows provides an emulated IBM 101-key keyboard
that maps to the host keyboard.

Mouse

The host mouse is used. SoftWindows’ own mouse driver allows the mouse to move
between the PC and host windows acting as expected in both environments.

Hard disks

SoftWindows uses two UNIX files as the PC’s C: and (optionally) D: drives. Each drive
can be configured to be up to 500 Mbytes. UNIX directories can be used for network
drives D: through Z: using the SoftWindows Virtual File Sharing Architecture (VFSA).
VFSA allows PC software to access UNIX files and vice versa.
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Floppy disk drives

Drives A: and B: are supported using the host’s 3.5-inch drive.

Sound and video

SoftWindows includes drivers to allow wav sound files and avi video files to be played
from Windows, using the workstation hardware. It also includes MIDI and Sound Blaster
support.

Serial port

Four communications ports are supported (COM1, COM2, COM3, and COM4) with
selectable baud rate, parity, and word format. The serial port on the host is used as a
communications port.

Parallel ports

Three standard PC printer ports are supported: LPT1, LPT2, and LPT3.

CDROM

A CD-ROM driver allows PC-format CD-ROMs to be read from within SoftWindows.
The Microsoft CD-ROM extensions are incorporated, including CD Audio.

Networking support

SoftWindows includes a set of NDIS, Winsock, and ODI-compliant network drivers and
can take advantage of your UNIX Ethernet connection to access other PCs and services
on your network.
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Technical specification

The following table details the SoftWindows specification.

Table 1-1 SoftWindows Technical Specification Details

Feature Specification

Processor Pentium MMX

Math processor 487 Floating Point Unit

ROM BIOS PC/AT-compatible

Memory 1 Mbyte to 255 Mbytes (note the initial default  range is 1 Mbyte to
32 Mbyte)

Floppy disk drives Two drives, A: and B:

Hard disk drives Two drives, C: and D:

VFSA drives D: to Z:

CD-ROM Data on first available VFSA drive

Networking Ethernet, NDIS, Winsock, and ODI drivers

Video Accelerated Windows display adapter and drivers optimized for
Windows 95 (including DirectX) and Windows 3.1.

Super Video Graphics Array (Video 7) for MS-DOS. SVGA modes
supported: 40h to 45h, and 60h to 69h except 63h and 64h

Audio Windows WAVE audio device (including DirectSound support
under Windows 95)

Parallel ports Three ports, LPT1:, LPT2:, and LPT3:

Serial ports Four ports, COM1:, COM2:, COM3:, and COM4:

Keyboard PC/AT 101/2-key keyboard

Mouse Microsoft Bus Mouse compatible

Microsoft Windows Windows 95 (Windows 3.11 for upgrade installations)
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2. Using SoftWindows

This chapter describes how to run SoftWindows, and how to use it to run Windows and
MS-DOS applications on your UNIX workstation.

SoftWindows initially runs in a separate X Windows window, and you can run PC
applications at the same time as your UNIX applications.

For full installations, SoftWindows is set up to launch Windows 95 automatically as soon
as you run it.

If you want to use MS-DOS you can either run MS-DOS in a window, or exit from
Windows 95 to the SoftWindows MS-DOS window.

Running Windows

To run SoftWindows, type the following command in a UNIX terminal window:

SoftWindows95

The Windows 95 welcome screen will then be displayed.
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Running SoftWindows for the first time

1. The first time you run SoftWindows a hard disk file is created and saved in your
home directory under the name WIN95-username.hdf, where username is your UNIX
login ID. This may take several minutes. If this file already exists, SoftWindows uses
it as your bootable C: drive.

2. Choose Continue to create the hard disk file, or Exit to exit from SoftWindows.

If the option to install the hard disk data file was not selected during a full
installation, a dialog box appears.

3. Enter the path to the data file WIN95.DAT (provided on the second installation
CD-ROM CD2) in the Data File... field.

For example, if CD2 is mounted in the /CDROM directory, enter
/CDROM/WIN95.DAT.

If there is insufficient space to create the hard disk file in your home directory, a
dialog box offers you the option to specify an alternative location.

4. Choose OK if you want to specify an alternative location for the hard disk file, or
Exit to exit from SoftWindows.

If you choose OK, a dialog box appears.

5. Choose the location in which to create the file, enter a name for the file in the
Selection field, then click OK.

Softwindows creates the hard disk file in the location you specify, and a symbolic
link in your home directory called WIN95-username.hdf that points to the hard disk
file.

Certain batch files then run to load the latest device drivers.

A dialog box will be displayed to allow you to choose the size of the Windows
desktop.

6. Select the size you want, then choose OK to run Windows.

Note that increasing the size of the window will require more memory and may
reduce performance.

7. The Enter Windows Password dialog box appears and prompts you to supply a user
name and optional password.

The Windows 95 desktop will then be displayed as shown on the previous page. For
more information about Windows 95 refer to Chapter 3, “Using Windows 95.”
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Restarting and quitting SoftWindows

To restart SoftWindows

1. Choose Restart… from the Actions menu.

A dialog box warns you that work can be lost if you have not saved files before
restarting.

2. Choose OK to restart.

Restarting SoftWindows has the following effect:

• In Windows 95, the Shut Down Windows dialog box is displayed, allowing you to
shut down Windows, restart, or cancel the operation.

• In Windows 3.11, Windows restarts immediately without offering the option to
cancel the operation.

To freeze SoftWindows

If you are switching between SoftWindows and UNIX applications, you can either
manually freeze SoftWindows or set SoftWindows to automatically freeze when it loses
window focus. This lets you optimize your use of the available CPU resources on your
system.

To freeze SoftWindows, choose Freeze from the Actions menu.

When you choose Freeze, SoftWindows stops running without affecting the
SoftWindows window, and a button is displayed against the menu function. Select
Freeze again to restart SoftWindows.

Note that you should not use Freeze if you are using network resources or are connected
to a LAN server, as any network connections could time out.

If you want SoftWindows to freeze automatically whenever its window does not have
focus, choose Auto Freeze from the Options menu. SoftWindows will unfreeze as soon
as focus is returned to its window.
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To exit from SoftWindows

1. Choose Exit from the File menu.

A dialog box appears.

2. Choose Create TurboStart data file to use TurboStart.

This saves your work so that Windows 95 loads instantly the next time you run
SoftWindows, and you can resume where you left off. By default SoftWindows saves
the the TurboStart data in .swinturbo in your home directory. You can configure
SoftWindows to use a different file. See “To specify the TurboStart data file.”

Alternatively you can choose Shutdown from the Windows 95 Start menu to quit without
TurboStart. When you next run SoftWindows, Windows 95 will be restarted in the usual
way.

You can also choose Exit from the File menu and deselect the Create TurboStart data file
option.

Save Configuration Changes is selected by default if you have made any configuration
changes. This saves any changes you have made to the configuration of SoftWindows in
your .swinconfig file.

If you do not want to save any changes, deselect the Save Configuration Changes option
before selecting OK. For more information refer to “Configuring SoftWindows” in the
SoftWindows 95 for UNIX Administrator’s Guide.

To specify the TurboStart data file

1. Choose Turbo from the File menu.

A dialog box appears.

2. Type the name of the TurboStart data file you want to create into the text box.
Alternatively, click TurboStart File...

A dialog box lets you select the directory in which you want to save the Turbostart
data file.

3. Select a directory into which you want to save the file, append the name of the
TurboStart data file you want to create into the Selection field, then click OK.

The next time you start SoftWindows, Windows 95 is loaded instantly in the same state
as when you exited from SoftWindows, and the Turbostart data file is then deleted.
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TurboStart and Microsoft Internet Explorer

If you create a TurboStart data file and exit from SoftWindows while Internet Explorer is
running, when you restart SoftWindows you will also need to restart Internet Explorer.

Using the keyboard

SoftWindows can use most UNIX workstation keyboards to produce all the keys and key
combinations you need to run MS-DOS applications. SoftWindows provides support for
French, German, UK and US UNIX workstation keyboards.

The tables on the following pages list the keyboard keys, or key combinations, needed to
produce all the PC/AT keys that are found on a US version 101-key IBM keyboard that
do not directly correspond to particular UNIX workstation keys.

The PC/AT 101-key keyboard

The illustration provided below shows the layout and keycap engravings of the US
PC/AT keyboard. This is SoftWindows’s default keyboard emulation.

Figure 2-1 The PC/AT keyboard
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Using floppy disks

SoftWindows supports the use of 3.5-inch MS-DOS format floppy disks using the floppy
disk drives on your UNIX workstation.

Before using floppy disk drive A: or B: you need to assign it to the internal 3.5-inch floppy
disk drive on your computer, using the Open Drive… function on the Disk Drives
cascade menu on the Options menu; refer to “Setting up floppy disk drives” in the
SoftWindows 95 UNIXfor UNIX Administrator’s Guide.

Note: SoftWindows does not support D.M.F. 1.6 Mbyte disks.

To show the files on a floppy disk from Windows 95

Double-click the [A:] floppy disk icon in the My Computer folder:

To show the files on a floppy disk from MS-DOS

Type the following command at the MS-DOS C:\> prompt:

DIR A:

To eject a floppy disk

Choose Eject Floppy A: or Eject Floppy B: from the Actions menu.

To format a floppy disk

Use the MS-DOS FORMAT command; refer to FORMAT.

For details on the device names to use refer to “Setting up floppy disk drives” in the
SoftWindows 95 for UNIX Administrator’s Guide.
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Using CD-ROMs

You can work with MS-DOS format CD-ROMs using a CD-ROM drive attached to the
UNIX workstation.

Before you can use CD-ROMs you need to set up the CD-ROM drive; refer to “Setting up
the CD-ROM” in the SoftWindows 95 for UNIX Administrator’s Guide.

To show the files on a CD-ROM from Windows 95

Double-click the [F:] CD-ROM icon in the My Computer folder.

To show the files on a CD-ROM from an MS-DOS Prompt

Type the following command at the MS-DOS C:\> prompt:

DIR F:

To use a CD-ROM in MS-DOS mode

When running Windows 95 in MS-DOS mode:

1. Ensure that the following line appears in your config.sys file:

device=c:\insignia\cdrom.sys

2. Type the following command at the MS-DOS C:\> prompt:

USECD

This sets up the CD-ROM drive as drive F:, and you can now use it like any other drive.

The CD-ROM drive is configured automatically for use from a windowed or full screen
MS-DOS Prompt in Windows 95.
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To run CD-ROM applications

Follow the instructions supplied with the CD-ROM.

To eject a CD-ROM

Press the eject button on the CD-ROM drive.

Using PC files stored in UNIX

VFSA drives

SoftWindows includes software called the Virtual File Sharing Architecture (VFSA) that
allows PC files to be stored in the UNIX file system and still be accessed by Windows and
MS-DOS applications as though they were on a PC disk.

When using a PC, the VFSA drive would be on another computer and the PC would be
able to access it through a network driver. SoftWindows uses this attribute of
Windows 95 to access a specified UNIX directory, which can either be on your
workstation’s hard disk or on an NFS-mounted file system from a remote server.

The PC files in a VFSA drive reside as individual UNIX files and can be used by UNIX
programs that can work with PC files.

Filenames in Windows 95

Windows 95 filenames are not case sensitive, so upper and lower case letters are treated
as equivalent. When you set up a VFSA drive you specify the character case you prefer
to work with. Whenever you create a new file SoftWindows maps all files to a unique
filename except for filenames that are in the preferred case for the VFSA drive.

When assigning UNIX drives to a VFSA drive your preferred case must be either lower
or upper. The table below sumarizes the way file names are mapped from UNIX to
Windows 95 for each preferred case.
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When assigning case-insensitive drives (such as PC drives) to a VFSA drive you may
prefer to set the preferred case to Case Insensitive, which causes all file names to be
preserved regardless of case.

To enable Windows 95 to distinguish between files whose UNIX names differ only in case
(for example, fred.txt and FRED.TXT), you select a preferred case for each VFSA drive
you set up. SoftWindows preserves file names that are in the preferred case, but maps all
other files to a unique filename.

where ~abc is a code based on the check-sum value of the file.

Note: Some Windows 95 applications such as Windows Explorer display upper case
filenames in first caps. For example, you may see the file README displayed as Readme.

Mapping invalid filename characters

Windows files cannot contain the following characters:

\  /  :  *  ?  <  >  |

If a UNIX filename contains one or more of the above characters, each invalid character
is mapped to {nn}, where nn is a two-digit code. For example, a UNIX file named a:b will
be mapped to a{3a}b in Windows 95 (assuming the preferred case is set to Lower Case).

Table 2-1 Summary of Preferred Case Filename Mapping Between UNIX and Windows 95

Preferred Case UNIX
filename

Windows 95
filename

MS-DOS Prompt
(within Windows 95)

MS-DOS

Lower readme readme README README

README README~abc READ^ABC README

Upper readme readme~abc READ^ABC README

README README README README
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To save a PC file to UNIX

In SoftWindows, copy the file to a drive which has been set up as a VFSA drive.

For example, if you have set up your home directory as drive E:, save the file to the E:
drive.

You will then see the file in your home directory.

To copy a UNIX file to SoftWindows

Put the file in a directory you have set up as a VFSA drive.

For example, if you have set up your home directory as drive E:, you can make a file
available on the PC drive E: by putting it in that directory.

To list the UNIX directories setup as PC drives (MS-DOS only)

Type the following command in an MS-DOS window:

C:\INSIGNIA\NET USE

This will list the drive letter of each VFSA drive followed by the UNIX pathname of the
directory to which it is attached.

Note that the not sharing message is normal, and refers to MS-DOS SHARE.

When SoftWindows is first installed, the following drives are set up for you:

Table 2-2 Drives Available When You First Install SoftWindows

Drive UNIX directory

E: Your home directory

G: Directory required to run Microsoft Windows (Upgrade installation only)

H: Your home directory
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Note: For upgrade installations the G: drive points to the UNIX directory
$SWINHOME/windows, where $SWINHOME is the SoftWindows installation directory.
This contains files essential for running Microsoft Windows, and should not be made to
point to a different directory without consulting your system administrator. For further
information see your system administrator.

For more information about setting up VFSA drives, refer to “Setting up VFSA drives”
in the SoftWindows 95 for UNIX Administrator’s Guide.

Connecting to a PC network and the internet

SoftWindows is supplied with Winsock (1.1) drivers and Microsoft Internet Explorer
pre-installed and ready to use. For more details, see Chapter 5, “Using SoftWindows
with the Internet.”

SoftWindows includes networking software to enable you to access PC network file
servers from SoftWindows running on a UNIX workstation.

By default SoftWindows is not set up to access Local Area Network services. This
requires re-configuring Windows 95 to access the network device on the host
workstation via NDIS or ODI drivers supplied with SoftWindows.  See “Networking
with SoftWindows” in the SoftWindows 95 for UNIX Administrator’s Guide.

Once you have set up the network access you have the same access to a PC file server as
a PC user, including the ability to run multi-user PC applications.

Changing the default network card

To use a network card other than the default selected by SoftWindows, do the following:

1. Choose Network from the Options menu to display the Network Configuration
dialog, shown in Figure 2-2.

The dialog lists all available network cards on your UNIX machine, with the default
card selected.
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Figure 2-2 Network Configuration Dialog Box

2. Click on the check box next to the network card you want SoftWindows to use to
specify a different card.

If you have more than one Ethernet card installed, it is recommended that you only
select one of each type.

Using sound

Use the Sound function to use the UNIX workstation’s sound facilities to emulate PC
sounds. The initial default setting has sound disabled.

To enable/disable sound

1. Choose Sound from the Options menu.

A dialog box appears.

2. Choose Enable Sound to enable sound on the host workstation.

After choosing this function you will need to restart SoftWindows, and a dialog box
is displayed to allow you to proceed or cancel the function.
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3. Choose Enable Sound again to disable it.

Note that PC applications that generate complex sounds, such as digitized voices or
music, may run slowly even if the Sound function is disabled. In this case you
should turn off sound in the PC application.

4. With Sound enabled, choose Mute Sound to temporarily switch off sound without
affecting playback volume settings in individual Windows applications.

5. With Sound enabled, choose Ignore Windows Sound Volume if you want the
playback volume to be controlled by the Audio Control Panel settings on the host
workstation, instead of the playback volume settings in individual Windows
applications.

To reverse stereo channels

To reverse the left and right stereo channels:

1. Choose Sound from the Options menu to open the Sound panel.

2. Click the box next to Reverse Stereo Channels. A checkmark indicates the channels
are reversed.

Turning Sound Blaster on or off

Sound Blaster is typically used to enhance sound while playing video games. It is off by
default. To turn Sound Blaster on:

1. Choose Sound from the Options menu to open the Sound panel.

2. Select one of the following Sound Blaster options:

• Select Sound Blaster 16 for average quality sound.

• Select Sound Blaster Pro for the highest quality sound. Sound Blaster Pro
provides MPU-401 compatible MIDI support.

Select None to turn Sound Blaster off.
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To control input and output sound devices for .wav files

By default SoftWindows uses settings in the Audio Control Panel to determine the input
and output devices. Environment variables enable you to specify alternative devices for
SoftWindows; refer to “Setting up SoftWindows” in the SoftWindows 95 for UNIX
Administrator's Guide.

To control MIDI sound devices

To play and record MIDI sound files:

1. Choose Sound from the Options menu.

2. Choose Internal from the MIDI Device Type list to use an internal sound device such
as a software synthesiser.  In most cases you should choose the Software Synth
option from the Value Assignment list.

3. Choose External from the MIDI Device Type field to use an external sound device
connected to a serial port.  In most cases you should choose the Serial Port 1 option
from the Value Assignment list.

Using the CPU panel

If you are an advanced user, you can use the CPU panel to enable/disable FPU
emulation, to enable/disable MMX, and to enable/disable RDTSC.

To enable/disable FPU

Optimized Floating Point Emulation (FPU) is on by default. Optimized is potentially less
accurate, but faster. Standard is very precise, but slower. Optimized is recommended for
most applications, but if you experience problems, try switching to Standard. You can
also disable FPU by doing the following:

1. Choose CPU from the Options menu to open the CPU panel.

2. Click the box next to Floating Point Emulation. The checkmark disappears. To
re-enable it, click the box again.

After choosing this function you will need to restart SoftWindows, and a dialog box
is displayed to allow you to proceed or cancel the function.



Using the CPU panel

23

Note: Due to the different precisions of the PC FPU and the emulated FPU, some
programs may run differently than a PC when FPU emulation is enabled. For example,
the rounding of decimal numbers may be incorrect. In such cases the FPU emulation
should be disabled.

To enable/disable MMX

MMX is on by default. Since it can marginally slow down system performance, you may
want to turn it off if you aren’t using it:

1. Choose CPU from the Options menu to open the CPU panel.

2. Click the button next to MMX to turn it off. The checkmark disappears. To turn it
back on, click the button again.

After choosing this function you will need to restart SoftWindows, and a dialog box
is displayed to allow you to proceed or cancel the function.

To enable/disable RDTSC

The Read Time Stamp Counter (RDTSC) is on by default. It is required by certain
applications, such as NASCAR 2. If the application you’re using doesn’t need it, you can
turn it off to marginally increase system speed:

1. Choose CPU from the Options menu to open the CPU panel.

2. Click the box next to RDTSC to turn it off. The checkmark disappears. Click it again
to turn it back on.

After choosing this function you will need to restart SoftWindows, and a dialog box
is displayed to allow you to proceed or cancel the function.
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Activating and deactivating drives and ports

Use the Activate function to control which of the PC drives, A: to D:, or the PC ports,
LPT1: to LPT3:, or COM1: to COM4:, are reserved for use by SoftWindows.

SoftWindows will always try to activate a drive or port when it is first selected, according
to the settings in the Open Disk Drives, Comms Ports, and Printer Ports dialog boxes;
refer to the SoftWindows 95 for UNIX Administrator’s Guide, and “Printing, input, and
output.”

To see which devices are in use by SoftWindows

Choose Activate from the Actions menu.

Devices in use by SoftWindows are shown with a highlighted button next to their name
in the cascade menu.

Entries with no device assigned to them are shown grayed out in the menu.

To free a device so that another UNIX application can use it

Choose the corresponding drive or port from the Activate cascade menu.

To set read-only access on hard disk drives

Choose C Drive or D Drive from the Activate cascade menu.

When a button is shown beside the drive name, you have read and write access, and
other users only have read access.

When there is no button beside the drive name, you only have read access, allowing
another user to write to the drive.

Any number of users can have read access to a hard disk file, but only one can have write
access at any time.
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Printing, input, and output

On a PC, applications communicate with external devices such as printers and modems
via the COM1: to COM4: serial ports and the LPT1: to LPT3: parallel ports.

You can assign these ports to take advantage of the equivalent capabilities of the UNIX
workstation.

The following table summarizes the options for the COM and LPT ports:

After outputting from a SoftWindows COM or LPT port to a file or pipe, you need to
flush the output to ensure that the last partial buffer of data is sent to the file or pipe.

SoftWindows provides an Auto Flush option, which flushes the buffer automatically a
specified interval after the last activity on the port.

Alternatively, you can flush output from a port manually when you know that output
has finished.

To flush output automatically

1. Choose Auto Flush… from the Options menu.

A dialog box appears (Figure 2-3).

†. Output must be flushed.

Table 2-3 Summary of Options for COM and LPT Ports

Option Description

File Output redirected to a specified file†

Pipe Output directed to the print spooler for network printing†

Device Input/output to a device connected to the workstation’s serial port

None No device assigned
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Figure 2-3 Auto Flush Dialog Box

2. Check that the Enable Automatic Flushing box is selected.

3. Set the required delay by moving the Autoflush Delay slider until the value you
want is shown above the slider. You can set any autoflush delay from 1 to 300
seconds.

The ideal autoflush delay depends on how quickly the PC application outputs data, and
you may need to experiment by starting with a high value, and then reduce it to find the
best setting.

You can set flushing for an individual file or pipe by setting the Enable Windows
PostScript flushing option in the Printer Ports or Comms Ports dialog box.

Flushing with pipes

When data being sent to a pipe is flushed, the pipe process is stopped and another one is
started. If you are piping data to the print spooler, this will stop the current job and start
another one.

For pipes the autoflush delay must therefore be set to an interval greater than the time it
takes to generate each buffer of data for a particular job; otherwise unwanted print jobs,
and incorrect output, may be generated.
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To flush output manually

1. Choose Flush Ports from the Actions menu.

A cascade menu is displayed allowing you to select which ports to flush.

2. Choose All to flush all ports, or choose the port you want to flush.

The port should be flushed after outputting to a COM or LPT port from SoftWindows
with the Pipe option.

The buffers are also flushed automatically when you quit from SoftWindows.

Redirecting to a file and piping to a process

You can redirect all output from a specified port to a file in the UNIX file system.

Redirecting output from SoftWindows to a file is a useful way of debugging problems
with printing. The file can then be printed externally to SoftWindows.

To redirect output to a file

1. Choose Printer Ports… or Comms Ports… from the COM/LPT Ports cascade menu
on the Options menu, depending on whether you want to redirect an LPT or COM
port.

2. Choose File from the popup menu next to the port you want to redirect.

The filename defaults to SoftWin.tmp in your home directory. Alternatively, enter
the filename you want to use. If the file already exists, the output will be appended
to it.

3. Check that Enable Automatic Flushing is set in the Auto Flush dialog box, so that
output is flushed to the file; refer to “To flush output automatically.”

You can pipe the output from a port to a UNIX process that will accept text input. One
use for this is to print a file which is not PostScript.
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To pipe to a UNIX process

1. Choose Printer Ports… or Comms Ports… from the COM/LPT Ports cascade menu
on the Options menu, depending on whether you want to pipe the output from an
LPT or COM port.

2. Choose Pipe from the popup menu next to the port whose output you want to pipe,
and enter the name of the process.

Do not include the leading pipe symbol, |, as this is assumed. By default, output is
piped to lp, the UNIX print spooler.

3. Check that Enable Automatic Flushing is set in the Auto Flush dialog box, so that
output is flushed to the pipe; refer to “To flush output automatically.”

Serial input and output

A COM port can be attached to either of the serial ports for input and output, with
selectable serial parameters, using the Device option.

This option is intended for use by communications packages that provide their own
handshaking.

The following serial parameters are supported:

Baud rate: 50, 75, 110, 134.5, 150, 300, 600, 1200, 1800, 2400, 4800, and 9600.

The following combinations are supported:

Table 2-4 Support Com Port Combinations

Data bits Parity Stop bits

8 None 1

7 Even 1

7 None 2

7 Odd 1
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By default, COM1: is set up by the following MODE command in the AUTOEXEC.BAT
file:

MODE COM1:9600,N,8,1

This gives the following communications settings:

9600 baud, no parity, 8 data bits, and 1 stop bit

This setting can be changed with the MODE command.

To use serial input and output

1. Connect the serial device to the workstation’s serial port.

2. Choose Comms Ports… from the COM/LPT Ports cascade menu on the Options
menu.

The Comms Ports dialog box appears.

3. Choose Device from the COM1: popup menu.

You should enter the appropriate device name for the port you want to use. If
necessary, ask your system administrator.

4. If the serial device needs flow control, set Flow Control.

Serial port emulation

SoftWindows uses facilities provided by the UNIX terminal device drivers to determine
the state of the serial port. As a result, the PC/AT serial port cannot be fully emulated,
although most devices and packages designed to operate with it will work equally well
on SoftWindows.

The following technical details are provided for users who need specialized help in
getting a device or package to work properly or who are developing software which uses
the serial ports.
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DSR (Data Set Ready)

This line is always held high.

The effect is that devices can detect DTR (Data Terminal Ready), but a response from the
device via DSR cannot be detected by SoftWindows. Therefore SoftWindows cannot
support hardware handshaking, and XON/XOFF software handshaking should be used
instead.

RI (Ring Indicator)

This modem input signal cannot be detected and is forced off by the software.

Input errors

The occurrence of input overrun and framing errors in the hardware or an input break
condition cannot be detected.

Recommendations

The following should be noted if you are choosing a package to run under SoftWindows
on the UNIX workstation or you are developing software that uses the serial ports for
communication.

• You should normally use 4800 baud or lower. Higher speeds are likely to be less
reliable.

• The packet size should be kept small: 512 to 1024 bytes is a suitable size.

• Interrupt driven is preferable to polled data transfer. When SoftWindows receives
data from an external source with XON/XOFF data flow control, the program
running on SoftWindows may have problems. This is due to host buffering of input
data preventing the program from responding quickly enough to XOFF signals.
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3. Using Windows 95

This chapter explains how to run Windows 95, and gives information about working
with Windows 95 and running Windows applications.

It includes a short tutorial to introduce you to the procedures for working with
Windows 95.

Running Windows 95

Windows 95 starts in seconds with TurboStart, and you can resume your work where
you left off when you quit.

The first time you run SoftWindows the Windows 95 desktop (Figure 3-1) will be
displayed.
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Figure 3-1 Windows 95 Desktop

To use the mouse

As you move the UNIX mouse pointer onto the SoftWindows window it automatically
changes to the Windows mouse pointer, so that you can switch freely between Windows
and UNIX applications.



Tutorial

33

To exit from Windows 95

The recommended way to quit from Windows 95 is to use TurboStart; refer to “To exit
from SoftWindows.”

However, if you specifically want to exit from Windows 95 proceed as follows:

1. Click the Start button, then click Shut Down….

A dialog box lets you choose how to shut down.

2. Click Yes to choose the first option and shut down Windows 95.

SoftWindows will then automatically exit.

Tutorial

This Tutorial is designed to help you become familiar with using SoftWindows by
installing and running a typical Windows application, and printing from Windows.

It is based on the award-winning Windows program WinPost, which is supplied with
your SoftWindows package. WinPost lets you create simple reminders which you can
leave on your Windows desktop. It is a PC shareware application, so if you like it and
decide to continue using it please send the author the registration fee, as described in its
online manual.

Run Setup

Most Windows 95 applications are installed by running a standard Windows setup
procedure.

The installer and its associated files are supplied in the C:\WNPST  folder.

1. Click the Start button on the taskbar, and then click Run….

The Run dialog box appears.

2. Type:

C:\WNPST\SETUP

3. Click OK to run the setup program.
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Specify where to install WinPost

A dialog box appears allowing you to specify the directory into which WinPost should
be installed.

Click OK to install in the WINPOST directory on your SoftWindows hard disk file.

The files are then copied to the directory you specified.

Finish the installation

A dialog box informs you when the installation is complete.

Click OK to return to the Windows desktop.

The installation creates a new WinPost folder containing the following shortcuts. These
are like UNIX links to the actual files:

• WinPost 3.2 is a shortcut to the WinPost application.

• WinPost Manual is a shortcut to documentation for WinPost. Double-click the icon
to display the document so that you can read it or print it out.

• Read Me! is a shortcut to additional information about WinPost.

When you install a Windows application the installer usually creates shortcuts for the
application, and for any other programs or documents you might need to use with it.
Often these are put in a separate folder.

For more information about the components of Windows 95 you may want to read
“Tutorial.”

To run WinPost

1. Double-click the WinPost 3.2 shortcut icon.

The first time you run WinPost, a shareware registration notice is displayed
informing you that you can evaluate WinPost for 21 days.

2. Click OK to dismiss the notice.

The WinPost program is now running and its icon is displayed in the taskbar at the
bottom of the Windows desktop.
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To display the WinPost menu

Point to the WinPost icon in the taskbar and click the right mouse button.

A pop-up menu appears above the taskbar.

Some of the commands on the WinPost menu are described below. For more information
about all the commands refer to the WinPost Manual file.

To create a new note

1. Display the WinPost menu, as described in the previous section.

2. Choose Default from the Create a note submenu.

An empty Note window appears.

3. Type in the information you want to remember.

The buttons along the top of the note provide useful functions. For example, the
first three are cut, copy, and paste just like the equivalent menu commands.

To print from a Windows application

You can print from Windows applications to your UNIX printer.

To illustrate printing from Windows try printing the note you have created.

Before printing you need to ensure that SoftWindows is set up for the UNIX printer you
want to use. For more information refer to “Printing from Windows applications.”.

To print a note

1. Click the control menu button, in the top left corner of the Note window, to display
the control menu.

2. Choose Print this note….

Alternatively, you can use the key shortcut Alt-P.

3. When the Print dialog box appears click OK to print the note.
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Getting help on Windows 95

Windows 95 includes a comprehensive help system, with answers to most problems you
are likely to have.

To display Windows Help

Click the Start button, then click Help.

The Windows Help window appears showing the list of help topics.

To find help from the contents

1. Click the Contents tab to show the help topics grouped by subject.

2. Click a book icon to display the contents of that book.

3. Click a help topic icon and then click Display to display help on that topic.

To find help from the index

1. Click the Index tab to show an alphabetical list of topics.

2. Click a help topic and then click Display to display help on that topic.

To find help topics containing a word or phrase

1. Click the Find tab, and then type in the word or phrase you want to find.

A list of matching topics will be displayed.

2. Click a help topic and then click Display to display help on that topic.

To get help on an item on the screen

1. Point to the item and click the right PC mouse button.

A What’s This? box appears.

2. Click What’s This? to display an explanation of the item.



Copying and pasting text and graphics in Windows 95

37

Copying and pasting text and graphics in Windows 95

SoftWindows includes a utility called SmartCopy, which converts text and graphics
between the Windows 95 and X Windows clipboards, so that you can copy or cut and
paste between X Windows and Windows 95 applications.

When SmartCopy is running its icon appears at the right end of the taskbar.

When you move the mouse pointer out of the SoftWindows window the SmartCopy icon
changes to show whether text or graphics is ready to paste into an X Windows
application.

To copy text from X Windows to Windows 95

1. Choose the appropriate command in the X Windows application to copy the text
you want to transfer.

2. Move the mouse focus to SoftWindows.

SmartCopy translates the text to Windows 95 format on the Windows clipboard,
and you can use the Clipboard Viewer to view it.

3. Move the mouse pointer to position the cursor where you want to paste the text.

4. Choose Paste from the Edit menu of the Windows 95 application into which you
want to paste the text.

To copy graphics from the UNIX workstation screen to Windows 95

Choose From Display from the Paste Graphics cascade menu on the Actions menu.

The cursor changes into crosshairs, allowing you to select a portion of the display which
will be copied to the Windows 95 clipboard.

Position the cursor over one corner of the area to be copied, hold down the left mouse
button, drag the cursor to the diagonally opposite corner and release the mouse button.

You can view the graphic as follows:

1. Open the Clipboard Viewer.

2. Choose DIB Bitmap from the Display menu.
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Note: Windows 95 does not install the Clipboard Viewer by default.  To install this utility,
run Add/Remove programs from the Windows 95 Control Panel, choose Accessories
from the Windows Setup tab and click the Details... button, then click the Clipboard
Viewer check box in Components.

To paste the graphic into a Windows 95 application

Choose Paste from the Edit menu of the Windows 95 application into which you want to
paste the graphic.

To copy graphics from X Windows to Windows 95

1. Choose the appropriate command in the X Windows application to copy the
graphic you want to transfer.

2. Switch to SoftWindows.

3. Choose Paste Graphics from the Action menu, and choose the From Application
option.

The graphic is converted into Windows 95 format on the Windows 95 clipboard.

4. Choose Paste from the Edit menu of the Windows 95 application into which you
want to paste the graphic.

To copy text or graphics from Windows 95 to X Windows

1. Select the text or graphic you want to copy from the Windows 95 application.

2. Choose Copy from the application’s Edit menu.

The text or graphic is put into the Windows 95 clipboard, and you can use the
Windows 95 Clipboard Viewer to view it.

3. Switch to the X Windows application you want to use.

SmartCopy translates the text or graphic to X Windows format in the X clipboard.

4. Choose the appropriate command to paste in the text or graphic you copied.
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Printing from Windows applications

If your UNIX printer is a PostScript printer, you will get the best results by printing
PostScript from Windows.

You can also use SoftWindows to print to PC network printers that are not directly
accessible to UNIX. For more information refer to your PC network documentation.

To print PostScript to the UNIX printer

1. Choose Printer Ports… from the COM/LPT Ports cascade menu on the Options
menu.

The Printer Ports dialog box appears.

2. Choose Pipe from the LPT1: popup menu.

3. Enter $SWINHOME/bin/PS as the Pipe option.

This pipes the output through the PS utility to remove the Ctrl-D which is added by
some Windows or MS-DOS applications.

4. Set Enable Windows PostScript Flushing to flush output to the pipe; refer to
“Flushing with pipes.”

This ensures that PostScript is printed as a single printer job.

PS acts like lp or lpr, and as with these commands you can choose a specific printer by
entering:

$SWINHOME/bin/PS -dprintername

To print from Windows to a non-PostScript printer

If your UNIX printer does not support PostScript, you should set up Windows for the
printer you are using.

1. Choose Printer Ports… from the COM/LPT Ports cascade menu on the Options
menu.

The Printer Ports dialog box appears.

2. Choose Pipe from the LPT1: popup menu. Check that this is set to the default
setting, which sends output to the local print spooler, lp.
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3. Set Enable Windows PostScript Flushing to flush output to the pipe; refer to
“Flushing with pipes.”

4. Click Start, then click Settings and Printers to display the Printers folder.

5. Select the appropriate option for your UNIX printer, and choose Set As Default from
the File menu.

6. Print from the Windows application; typically you do this by choosing Print… from
the File menu.

Installing and running Windows applications

Most Windows applications are installed using the standard Windows setup procedure.
Provided the Windows application is supplied on CD-ROM or 3.5-inch disks you can
install using your workstation’s drive.

Note: Some applications offer to install Direct X for you. Since SoftWindows includes a
highly optimized version of Direct X, you do not need to install it from these other
sources.

To install a Windows application

1. Insert the application’s installation CD-ROM or floppy disk into the workstation’s
floppy disk drive.

2. Click Start, then click Settings and Control Panel.

3. Double-click the Add/Remove Programs icon.

A dialog box appears.

4. Click Install… to start the installation.

The installation program locates the installer on the disk you inserted.

5. Click Finish to run the installer.

As the installation proceeds, dialog boxes will prompt you for any information
needed for the installation.
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To run a Windows application

1. Click Start, then click Programs.

2. Point to the folder containing the program, and then click the program.

For certain installations it may be necessary to have the Windows 95 upgrade CD-ROM
or SoftWindows 95 CD2 loaded.





43

Chapter 4

4. Using MS-DOS

This chapter describes the original operating system for PCs, called MS-DOS, which is
available from within Windows 95. This chapter explains the basics of how MS-DOS
works and how to use it.

Running MS-DOS

To display the SoftWindows MS-DOS window from Windows 95

Click Start, then choose MS-DOS Prompt from the Programs submenu on the Start menu.

To exit from Windows 95 to the SoftWindows MS-DOS window

1. Click the Start button, then click Shut Down….

2. Select Restart the computer in MS-DOS mode.

3. Click Yes to proceed.
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MS-DOS basics

MS-DOS lets you give commands by typing instructions at the MS-DOS C:\> prompt.

MS-DOS editor

MS-DOS includes a simple screen editor which you can use to create, edit, and print plain
text files. You can choose editing commands from menus and edit text using the mouse.
The MS-DOS editor is particularly useful for editing MS-DOS batch programs such as
AUTOEXEC.BAT and other files such as CONFIG.SYS.

EDLIN, the less powerful line editor provided with earlier versions of MS-DOS, is also
provided.

For more information

For more information about using MS-DOS we recommend the following books:

• Microsoft MS-DOS User’s Guide

• DOS for Dummies by Dan Gookin, from IDG Books

Getting help on MS-DOS

MS-DOS includes a comprehensive help system which you can use to display
information about MS-DOS commands, and the procedures for using MS-DOS.

To display information about an MS-DOS command

Type the following at the C:\> prompt:

command /?

where command is the name of the command.

For example, to get help on the DIR command type:

DIR /?
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Using the SoftWindows MS-DOS window

To resize the SoftWindows MS-DOS window

You can resize the SoftWindows MS-DOS window to one of three alternative fixed sizes,
1.0x, 1.5x, and 2.0x, up to the size of your workstation screen.

Drag the window by any of its resize corners.

When you release the mouse button the window will snap to the closest fixed size.

Status bar

The status bar shows the status of SoftWindows using the following indicators:

Table 4-1 Status Bar Indicators

Indicator What it means

A:/B: Floppy disk drive A:/B: is in use

Caps Lock Caps Lock mode is selected

Scroll Lock Scroll Lock mode is selected

Num Lock Num Lock mode is selected

SVGA The display type

MSW SoftWindows graphics driver is in use for Microsoft Windows.
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Using the mouse in MS-DOS

If you have a mouse attached to your computer, it will be automatically attached when
you run Windows applications. You can also use it with MS-DOS programs that support
a Microsoft Bus mouse by using the SoftWindows Attach Mouse command.

Note: Before you can attach the mouse ensure that MOUSE.COM has been started, either
from the AUTOEXEC.BAT file (the command is commented out by default), or by
entering the following command at the MS-DOS command prompt:

C:\> C:\INSIGNIA\MOUSE.COM

To use the mouse in MS-DOS

You can attach the mouse from the keyboard as follows. Hold down Ctrl-Alt and click
the middle mouse button (or both buttons on a two-button mouse).

When you attach the mouse the workstation mouse disappears. The SoftWindows
menus will be inaccessible, and you cannot access X Windows windows belonging to
other UNIX applications.

To restore the normal workstation mouse

Hold down Ctrl-Alt and click the middle mouse button (or both buttons on a two- button
mouse).
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Using the MS-DOS editor

To run the MS-DOS editor

Type the following command at the C:\> prompt:

EDIT filename

where filename is the name of the file you want to edit, or omit the filename to create a
new file.

For example, to edit the AUTOEXEC.BAT startup file type:

EDIT AUTOEXEC.BAT

The file will then be displayed in the MS-DOS editor window.

To use the mouse

Choose Attach Mouse from the Actions menu.

Ensure that MOUSE.COM has been started before you attach the mouse.For more
information refer to “Using the mouse in MS-DOS.”

To edit the file

1. Position the cursor using the arrow keys or by moving and clicking the mouse.

2. Type to insert text at the cursor.

To cut, copy, and paste text

1. Press and drag the mouse pointer over the text you want to cut or copy.

2. Use the Cut, Copy, Paste, and Clear functions from the MS-DOS editor’s Edit menu.
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To delete text

1. Press and drag the mouse pointer over the text you want to delete.

2. Press d or type the text you want to replace it.

To exit from the MS-DOS editor

1. Choose Exit from the editor’s File menu.

You can do this from the keyboard by typing A, F, X.

You will be prompted to save the file before exiting if you have made any changes
to it.

2. Click Yes, or press <Enter>, to save the changes and exit from the MS-DOS editor.

Using MS-DOS commands

You can type MS-DOS commands at the MS-DOS prompt as you would on a real PC.

The following list gives the most useful MS-DOS commands; refer to an MS-DOS
reference guide for more detailed information.

In the syntax for each command, square brackets indicate optional arguments.

Note that MS-DOS is not case-sensitive; that means MS-DOS treats upper and lower case
characters as equivalent.

Getting help

You can display help about any command by typing:

command /?
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CD

Changes the current directory.

Syntax

CD [path]directory

Example

To change your current directory to C:\LOTUS type:

CD C:\LOTUS

COPY

Copies one or more files between two directories.

Syntax

COPY [drive:][path]file [drive:][path]file

Example

To copy a file named BUDGET.WK1 from the LOTUS directory on your C: drive to the D:
drive type:

COPY C:\LOTUS\BUDGET.WK1 D:\BUDGET.WK1
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DEL

Deletes specified files.

Syntax

DEL [drive:][path]file

Example

To delete the file named \WP\REPORT.OLD on the D: drive type:

DEL D:\WP\REPORT.OLD

DELTREE

Deletes a directory and its subdirectories.

Syntax

DELTREE [drive:][path]directory

DIR

Lists the files in a directory.

Syntax

DIR [drive:][path][/W]

The /W (wide) option displays the files in columns.

Example

To list the files on your D: drive in the WP subdirectory in wide format type:

DIR D:\WP /W
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DOS2UNIX

Converts an MS-DOS text file to UNIX format.

Syntax

DOS2UNIX dosfile unixfile

Example

To convert README.TXT to HELP.C type:

DOS2UNIX README.TXT HELP.C

For more information refer to the SoftWindows 95 for UNIX Administrator’s Guide.

FORMAT

Formats a disk.

Syntax

FORMAT [drive:] [/option]

The options are shown in the following table:

Note that you should format only low-density disks in the 720 Kbyte format and only
high-density disks in the 1.4 Mbyte format.

A drive set up as a SoftWindows FSA drive cannot be formatted.

Table 4-2 Disk Format Options

To format Give this command

5.25-inch low density FORMAT A: /F:360

3.5-inch low density FORMAT A: /F:720

3.5-inch high density FORMAT A: /F:1.44
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Example

To format a high-density disk in drive B: type:

FORMAT B: /F:1.44

KEYB

Selects a foreign keyboard character set.

Syntax

KEYB [xx,,[[drive:][path][file]]]

where xx is a two-letter keyboard code and file is the name of the keyboard definition file;
refer to Setting up keyboards in the SoftWindows 95 for UNIX Administrator’s Guide.

Example

To use a French keyboard with the standard definition file type:

KEYB FR

MKDIR (MD)

Makes a subdirectory.

Syntax

MKDIR [drive:][path]directory

Example

To make a directory named PCAPPS on your D: drive, type:

MKDIR D:\PCAPPS
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RMDIR (RD)

Removes an empty directory.

Syntax

RMDIR [drive:][path]directory

Example

To remove the empty subdirectory named TEMP from your D: drive type:

RMDIR D:\TEMP

TYPE

Displays the contents of a text file on the screen.

Syntax

TYPE [drive:][path]file

Example

To display the contents of the file TEXT.OUT from the WP subdirectory on your D: drive
type:

TYPE D:\WP\TEXT.OUT
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UNIX2DOS

Converts a UNIX format text file to MS-DOS format.

Syntax

UNIX2DOS unixfile dosfile

Example

To convert UNIX.C to DOS.TXT type:

UNIX2DOS UNIX.C DOS.TXT

For more information refer to the SoftWindows 95 for UNIX Administrator’s Guide.

XCOPY

Copies files and directories, including their subdirectories.

Syntax

XCOPY [drive:][path]file [drive:][path] /S

where the /s switch ensures that all the subdirectories are also copied.

Example

To copy all the files and directories from your C: drive to your D: drive type:

XCOPY C:\*.* D:\ /S
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Copying and pasting between MS-DOS and UNIX

When SoftWindows is displaying the MS-DOS window, text can be copied from and
pasted into the SoftWindows window using the following procedures.

To paste text into the SoftWindows MS-DOS window

1. Select the text you want to copy by holding down the Select mouse button (left, by
default) and dragging the pointer over the text in the UNIX window.

2. Lift your finger off the mouse button.

3. Move the mouse pointer into the SoftWindows MS-DOS window and position the
cursor where you want to paste the text.

4. Click the middle mouse button.

To copy text from the SoftWindows MS-DOS window

1. Select the text you want to copy, by holding down the left mouse button and
dragging the pointer over the text in the SoftWindows MS-DOS window.

2. Lift your finger off the mouse button.

3. Move the mouse pointer into the UNIX window and position the cursor where you
want to paste the text.

4. Click the middle mouse button.

The text will be typed into the UNIX window at the current cursor position.

Note: This may vary depending on the platform you are using. If you encounter
problems when pasting refer to your system documentation for details of how to paste
text.
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Printing from MS-DOS applications

Most MS-DOS applications give best results when set up for a dot-matrix printer such as
the widely-used LQ-2500.

To print from MS-DOS to a non-PostScript printer

1. Choose Printer Ports… from the COM/LPT Ports cascade menu on the Options
menu.

The Printer Ports dialog box appears.

2. Choose Pipe from the LPT1: popup menu. Check that this is set to the default
setting, which sends output to the local print spooler, lp.

3. Set Enable Windows PostScript Flushing to flush output to the pipe; refer to
“Flushing with pipes.”

4. Choose the appropriate command to print from your MS-DOS application.

To print to a serial printer with default settings

You can print from an LPT port to a serial printer with the following fixed
communications settings:

9600 baud, no parity, 8 data bits, 1 stop bit, XON/XOFF handshaking

1. Connect the printer to the serial port.

2. Choose Printer Ports… from the COM/LPT Ports cascade menu on the Options
menu.

The Printer Ports dialog box appears.

3. Choose Device from the LPT1: popup menu. By default this sends output to one of
the serial ports. You may need to change this depending on which port you are
using.
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To print to a serial printer with selectable settings

If you need to use different communications settings, set a COM port to Printer and use
the MODE command to set the communications parameters. For example:

MODE COM1:9600,N,8,1

sets 9600 baud, no parity, 8 data bits, and 1 stop bit, the default setting. XON/XOFF
handshaking is supported.

If your application can only print to an LPT port, use the MODE command to direct LPT
output to the COM port, for example:

MODE LPT1:=COM1:

Include the MODE commands in your AUTOEXEC.BAT file if you want to use these
settings every time you run SoftWindows.

Installing MS-DOS applications

To install an MS-DOS application you should follow the installation instructions in the
manual supplied with the application.

MS-DOS software is typically supplied on one or more floppy disks, and to install the
program you copy the files from these disks to your PC hard disk.

To simplify the installation process most PC programs provide a batch file which
automatically copies the files for you. The batch file is typically called SETUP.BAT or
INSTALL.BAT, and you run it by typing SETUP or INSTALL at the MS-DOS prompt.
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To install from 3.5-inch disks

The simplest way of installing PC software, if you have a floppy disk drive available, is
to install directly from 3.5-inch installation disks.

A typical sequence will be as follows:

1. Set up the workstation’s floppy disk drive as drive A: or B:; refer to “Setting up
floppy disk drives” in the SoftWindows 95 for UNIX Administrator’s Guide.

A: or B: appears in the SoftWindows status bar, indicating that the drive is available
to SoftWindows, and you can now access the disk from SoftWindows.

2. Follow the instructions supplied with the software. For example, you may be
instructed to type:

A:\SETUP

If at any stage in the installation you need to change disks, refer to “To eject a floppy
disk.”

To install from 5.25-inch disks

If the software is supplied on 5.25-inch disks, in some cases you can use a PC to copy the
software onto 3.5-inch MS-DOS format disks, and then install from these.

Installing from a VFSA drive

Instead of installing directly from 3.5-inch disks, you can copy the software from a PC to
a directory on your workstation via a network or serial connection. Attach the directory
to SoftWindows as a VFSA drive so that you can access the files in it from SoftWindows,
as described in Setting up VFSA drives in the SoftWindows for UNIX Administrator’s Guide.
Then install from the files in this directory.

Note that some installer programs assume that you are installing from floppy disk. They
may not work correctly if you copy all the files to a hard disk first, and then try installing
from the hard disk.
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Where to install

The installation program will typically give you the option of where to install the files it
is copying from the installation disks.

You have the following options:

Note that some PC application installer programs will only install onto a hard disk. Also,
some installers will assume that drives E: to Z: are a PC network, and install additional
networking software if you specify these drives.

Disk space requirements

Before installing onto the hard disk, check the disk space requirements specified in the
PC application’s manual, and verify the available hard disk space. For example, if you
are installing to drive C: type:

CHKDSK

at the C:\> prompt in SoftWindows.

Note that 1048576 bytes = 1 Mbyte.

If you do not have enough space on your hard disk to install the application, refer to the
SoftWindows 95 for UNIX Administrator’s Guide for details on how to enlarge or create
hard disk drives.

Table 4-3 Installing Files

Install here To do this

Drive C: or D:
SoftWindows hard
disk file.

If you are sure that the files you are installing will fit on your
SoftWindows hard disk file, and you do not need to access the files
using other UNIX programs.

Drive D: to Z:
SoftWindows VFSA
drive; refer to Using
PC files stored in
UNIX.

If you want to install into the UNIX file system rather than your
SoftWindows hard disk file so that you can share data with other UNIX
applications or other SoftWindows users.
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5. Using SoftWindows with the Internet

SoftWindows includes Microsoft Internet Explorer and a range of Internet utilities, to
allow you to access the World Wide Web from SoftWindows, and to download files for
use with your PC applications.

SoftWindows also provides a range of Internet utilities, to allow you to access the World
Wide Web from SoftWindows, and to download PC files from the Internet.

This chapter explains how to run Internet Explorer, and shows how to use it to access
up-to-the-minute technical support.

Running Internet Explorer

Microsoft Internet Explorer is supplied already installed on your SoftWindows hard disk
file, and it is set up so that you can use it to access the World Wide Web.

Before running Internet Explorer your workstation  needs to be connected to the Internet.

To run Microsoft Internet Explorer from Windows 95

Double-click the The Internet icon (Figure 5-1) on the Windows 95 desktop.

Figure 5-1 Internet Icon in  Windows 95

The Microsoft Internet Explorer window will then be displayed.
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Getting Microsoft support

You can also use the Internet Explorer to access Microsoft’s World Wide Web support
page, to get support on using Windows and other Microsoft products.

To reach Microsoft’s support site

1. Enter the following address in the internet Explorer address field:

http://www.Microsoft.com/support/

2. Press <Enter>.

After a short delay the Microsoft support home page will be displayed.

3. Click on the button corresponding to the support topic you are interested in.

Using Internet utilities

SoftWindows includes several Internet utilities to help you work with the Internet.

These utilities are supplied already installed. To run them from Windows 95 click the
Start button, then click Programs.

To run them from Windows 3.11 open the appropriate program group and double-click
the application’s icon.

For more information about each utility double-click the Read-Me file icon in the
appropriate folder on the C: drive.

Compressing and expanding files

These utilities allow you to compress files, to save time when sending them as
attachments to email, or to expand files that you have received with email or
downloaded from the Internet.

• PKZIP, from PKWARE, compresses and expands files using the popular .ZIP format.

For more information contact PKWARE’s Web site at:

http://www.pkware.com
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• Stuffit Expander expands and decodes files in a variety of formats, including Stuffit
(.SIT), UUENCODE (.UUE), and Binhex (.HQX).

For more information contact Aladdin Systems’ Web site at:

http://www.aladdinsys.com

Viewing files in different formats

A range of viewers are provided, to enable you to view files you have downloaded from
the Internet, even if you do not have the application that created them.

• Shockwave provides viewers for documents created with Macromedia’s products:
Director, FreeHand, and Authorware.

For more information and sample files contact Macromedia’s Web site at:

http://www.macromedia.com

• Ppview32 is a viewer for documents in Microsoft PowerPoint format.

SoftWindows 95 also includes Microsoft viewers for Excel and Word.

• The Acrobat reader views on-line versions of documents created in Acrobat (.PDF)
format.

For more information about setting up your Web browser to recognize Acrobat
Reader, and sample Acrobat files, contact Adobe’s Web site at:

http://www.adobe.com

Playing sound files

RealAudio is a compact sound format for transmitting sound files over the Internet.  On
Windows 95, RealAudio is included with Internet Explorer.  On Windows 3.11, it is
provided in the RealAudio program group.

To hear a sample sound double-click the Example 1 or Example 2 icons.

For more information contact RealAudio’s Web site at:

http://www.RealAudio.com





65

Chapter 6

6. Troubleshooting

This chapter contains three sections: commonly asked questions about using
SoftWindows, suggested solutions to problems that you may encounter when running
PC applications on your workstation with SoftWindows, and lastly, details of the
SoftWindows and MS-DOS error messages with explanations and suggested solutions.

About troubleshooting

The SoftWindows troubleshooting information is divided into the following  sections:

• “Common questions” discusses commonly asked questions about using
SoftWindows.

• “Common problems” discusses the most commonly encountered problems when
using SoftWindows.

• “Installation Errors” discusses common SoftWindows installation errors and how to
fix them.

• “MS-DOS errors” contains details of the MS-DOS error messages, with explanations
and suggested solutions.

• “SoftWindows VFSA errors” contains details of the SoftWindows VFSA (Virtual File
Sharing Architecture)  error messages with explanations and suggested solutions.

• “SoftWindows errors” contains details of the SoftWindows VFSA (Virtual File
Sharing Architecture)  error messages with explanations and suggested solutions.

• “Networking errors” contains suggested solutions to problems that you may
encounter when running PC applications on your workstation with SoftWindows.

• “Troubleshooting TCP/IP” discusses common TCP/IP problems and how to fix
them.

• “Troubleshooting ODI” discusses common ODI problems and how to fix them.
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Common questions

The following sections contain answers to the most commonly asked questions about
using SoftWindows.

Using floppy disks

• How do I format a floppy disk?

Refer to “To format a floppy disk.”

Using hard disks

• How do I create a new hard disk?

Use the New Drive… function on the Disk Drives… cascade menu on the Options
menu; refer to the SoftWindows 95 for UNIX Administrator’s Guide.

• How do I make a hard disk file larger?

Use the Modify Drive… function on the Disk Drives… cascade menu on the
Options menu; refer to the SoftWindows 95 for UNIX Administrator’s Guide.

• How do I share hard disks?

Make the hard disk read-only; more than one user can then read data from it. To do
this, enter the following command in a UNIX terminal window:

chmod 444 filename.hdf

where filename.hdf is the name of the hard disk file.

It may be useful to use the RO_DISK_PANEL_DISABLE configuration option; for
more information refer to the SoftWindows 95 for UNIX Administrator’s Guide.

• Can I use hard disk files from other versions of SoftWindows or SoftPC?

You can use a hard disk file from other versions of SoftWindows as D:. Before you
can use an old hard disk file as drive C: you need to upgrade it to the current
version of Windows. For information on upgrading your old SoftWindows hard
disks, refer to the SoftWindows 95 for UNIX Administrator’s Guide.
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Using CD-ROM

• How do I set up a CD-ROM drive?

Refer to the SoftWindows 95 for UNIX Administrator’s Guide.

• How do I read an MS-DOS CD-ROM?

Refer to “Using CD-ROMs.”

Using memory

• How do I change the memory setting for PC applications?

Use the Memory dialog box; refer to the SoftWindows 95 for UNIX Administrator’s
Guide.

Using keyboards

• How do I set up a foreign keyboard in Windows?

Use the Windows Keyboard control panel; refer to the SoftWindows 95 for UNIX
Administrator’s Guide.

• How do I set up a foreign keyboard in MS-DOS?

Use the MS-DOS KEYB command; refer to the SoftWindows 95 for UNIX
Administrator’s Guide.

Using the screen

• How do I change the size of the SoftWindows screen?

When you are running Windows, you can specify any size, up to the full screen;
refer to the SoftWindows 95 for UNIX Administrator’s Guide.

When running MS-DOS you can select between 1.0x, 1.5x, and 2.0x scales in the
Display dialog box; refer to “To resize the SoftWindows MS-DOS window.”
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Using printers

• How do I set up the COM and LPT ports?

Refer to “Printing, input, and output.”

• How can I print from a Windows application?

Refer to “Printing from Windows applications.”

• How can I print from an MS-DOS application?

Refer to “Printing from MS-DOS applications.”

Using serial devices

• How do I use the serial ports with PC applications?

Refer to “To use serial input and output.”

Converting between MS-DOS and UNIX

• How do I convert text documents between PC and UNIX?

If the documents are on a SoftWindows hard disk file, you can use the MS-DOS
utilities DOS2UNIX and UNIX2DOS; refer to DOS2UNIX or UNIX2DOS.

If they are in the UNIX file system, you can use the UNIX utilities dostounix and
unixtodos supplied in the $SWINHOME/bin directory.

• How can I copy and paste between PC and X Windows applications?

Use the SoftWindows copy and paste facilities; refer to “Copying and pasting
between MS-DOS and UNIX.”
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Setting UNIX file access

• What are UNIX file access permissions?

File access permissions are used to tell a computer system who has access to files
and directories. Files and directories have a set of permissions to determine which
users can read, write, and execute the contents of a file. If a system is shared or is
part of a network, other people may need access to its files and directories.

By setting file access permissions you control who is able to read, write, and use
your files and directories.

There are four types of permissions for files and directories:

Any of the permissions can be assigned to three categories of users:

Table 6-1 Permissions for Files and Directories

Permission Symbol What it means

Read r Allows users to view or copy a file, or list files in a directory.

Write w Allows users to create, edit, and delete a file. For a directory,
the write permission allows users to create or delete files only.

Execute x Allows users to run an executable file, such as a program or
application, and search a directory.

SUID s Runs a UNIX executable as its owner, rather than as the user
who launched it. SoftWindows uses this to gain access to
network devices normally unavailable to the user.

Table 6-2 Users and Symbols for Permissions

User Symbol What it means

Owner u The creator of the file (or directory)

Group g The other users in the owners group

Others o All other users
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• How do I check UNIX file access permissions?

You can check file access permissions using the UNIX ls -l command.

In a UNIX terminal window, move to the directory containing the file by typing the
command:

cd pathname

Then type:

ls -l filename

The output will be of the form:

-rwxrwxrwx 1 root 512 jun 9 09:35 filename

where the file access permissions are represented by the letters rwxrwxrwx; r is for
read, w write, and x execute. The three sets are for the Owner, Group, and Others,
respectively.

• How do I change UNIX file access permissions?

You can change file access permissions using the UNIX chmodcommand.

To change the permissions you need to be logged in as the owner or root. If
necessary, ask your system administrator to do this. Then issue the chmod command
with an appropriate parameter.

The parameter consists of u (owner), g (group), or o (other), followed by + or - to add
or remove permissions respectively, and the type of access: r (read), w (write), or x
(execute).

For example, to make a file so that the Owner can read it or write to it, and the
Group can write to it, give the commands:

chmod u+rw filename

chmod g+w filename

For more information on file access permissions consult your UNIX reference
manuals.
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Using Configuration files

• Where is my SoftWindows configuration stored?

In the .swinconfig file in your home directory; refer to the SoftWindows 95 for UNIX
Administrator’s Guide.

• What determines the configuration of MS-DOS?

The MS-DOS files AUTOEXEC.BAT and CONFIG.SYS; refer to MS-DOS
configuration, in the SoftWindows 95 for UNIX Administrator’s Guide.

Running PC applications

• How do I install PC software with SoftWindows?

Refer to “Installing and running Windows applications,” and “Installing MS-DOS
applications.”

• How do I give MS-DOS commands?

Type them at the C:\> prompt; refer to “Using MS-DOS commands.”

• How can I edit MS-DOS files?

Use the MS-DOS editor, EDIT; refer to “Using the MS-DOS editor.” In Windows you
can use the Windows Notepad text editor.

Using Windows

• What Windows drivers does SoftWindows use?

When you run Windows in a window you are not using one of the emulated display
drivers (SVGA or Hercules), and the title bar changes to SoftWindows Desktop to
indicate that you are using the SoftWindows Windows display and mouse drivers.
These are called SoftWindows Display and SoftWindows Mouse.
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Common problems

The following sections contain solutions to the most frequently encountered problems
when using SoftWindows.

Using the mouse

• The workstation mouse pointer has disappeared

While the mouse is attached for use by MS-DOS applications it is not available to
UNIX programs. To detach it refer to “Using the mouse in MS-DOS.”

Using printers

• Printing is not working properly

If you are using the print spooler, flush the port to ensure that all the data has been
sent. Disable autoflush and flush the port manually.

Redirect print output to a file, then print the file outside SoftWindows; refer to
“Redirecting to a file and piping to a process.”

Using VFSA drives

• I get an error message when I try to use an MS-DOS file on a VFSA drive

Because Windows and MS-DOS were not designed to handle file ownership and
permissions like the UNIX system, Windows and MS-DOS use an assortment of
standard file error messages to indicate that you do not have permission to read,
write to, or execute a given file or directory.

The following messages may indicate that you do not have access to a particular file
or directory due to the file permissions:
File creation error
File not found
Invalid directory
Invalid path (or file not found)

If one of these messages appears in MS-DOS and you are certain that the file or
directory exists, you should check the permissions and ownership using UNIX.
Refer to “Setting UNIX file access.”
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Also note that an Suid bit with incorrect ownership will cause permission problems
on VFSA drives.

Alternatively, copy the files to the hard disk C: or D: and try again.

Using networking

Problems experienced with SoftNode generally tend to be one of two types – problems
with the ODI driver loading or configuring itself, or problems with networking
applications after the software has been loaded.

• Network driver problems

If the driver completely fails to load, it will display a message which says:

Could not find a host network card

This means that SoftNode has been unable to make contact with the networking
facilities on the host machine. This is normally due to one of two things:

– SoftWindows has lost its SUID bit. The SoftWindows executable must be owned
by root and have mode 4555.

– The network package which SoftWindows requires is not installed on the host
workstation. For more information about which software package must be
installed on each system refer to "Networking with SoftWindows" in the
SoftWindows 95 for UNIX Administrator’s Guide.

Running PC applications

• No display is visible in the SoftWindows window

A PC application may have been started with the wrong video mode. Change the
display type; refer to the SoftWindows 95 for UNIX Administrator’s Guide.

• Application fails to run at all or locks up SoftWindows

The application may be copy protected and installed on a VFSA drive. Reinstall on
drive C: or D:.

Alternatively, the application may require additional memory; refer to the
SoftWindows 95 for UNIX Administrator’s Guide.



74

Chapter 6: Troubleshooting

Using Windows 95

• Windows will not run

Windows 95 needs a minimum of 16 Mbytes of memory to run. Check that this has
been set correctly; refer to the SoftWindows 95 for UNIX Administrator’s Guide.

• Windows will not run with a read-only C: drive

Attempting to run Windows 95 with read-only disks is not recommended.

Installation Errors

SoftWindows environment not set

When starting SoftWindows after the initial run you may have problems reading man
pages or accessing SoftWindows files.

This may be because on some X servers running xdm the .profile or .login file is not
executed when you login, and therefore $SWINHOME is not set. In this case you should:

1. Add the following lines to your .xinitrc file in your home directory, taking care to
insert them before any code beginning Xclients:

if[ -f$HOME/.profile ]
then
cd $HOME
. .profile
fi

Note that .xinitrc is usually executed with a Korn shell rather than a C shell, and so
the .profile file is used rather than the .login file.

If you do not have a .xinitrc file in your home directory, refer to the manual pages
for the xinit command, and determine whether you can copy a default (or what
should constitute a default) .xinitrc file to your home directory.

Note that you must insert the above lines of code into your .xinitrc file if you have
had to create one.

2. Log out and log in again for the changes to take effect.
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Bad or missing fonts

This error occurs whenever SoftWindows detects that none of the fonts required are
available from the X server, or the fonts installed in the SoftWindows installation are not
usable by the X server. To resolve this problem you need to configure the X server to use
the relevant fonts in the SoftWindows installation. Use the command:

xset +fp install/fonts/SGI
xset fp rehash

where install is the SoftWindows installation directory.

To make the change permanent, include these commands in the .xinitrc file in each user’s
home directory. If the .xinitrc files does not already exist, create it and insert these
commands.

Alternatively, you can use a font not provided with SoftWindows using the following
procedure. You might want to do this if you need extended ANSI characters, such as ß,
, or accented characters, which ar e not included in the default font.

1. Select a suitable font name to use.

This can be done using a program such as xlsfonts or xfontsel.

Once a font is selected, the following line should be added to the SoftWindows 95
app-defaults file, found in $SWINHOME/sOftWindows:

sOftWindows*fontlist: fontname

where fontname is the string you selected above.

2. Then restart SoftWindows.
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MS-DOS errors

These errors appear in the SoftWindows window:

Table 6-3 MS-DOS Errors Appearing in the SoftWindows Window

Error Explanation Suggestion

Not ready error reading
drive A/B Abort, Retry, Fail

Your floppy disk drive is not
attached to SoftWindows, or
the specified drive is set to
Empty in the Open Disk
Drives dialog box, or there is
no disk in the drive.

Attach or select the floppy
disk drive, or insert a disk
and retry the command.

Invalid drive specification If you are trying to access
drive D:, there is no
SoftWindows hard disk file
selected as drive D:.

If you are trying to access an
VFSA drive, the software
needed to access VFSA
drives is not set up correctly.

Select a file as drive D:; refer
to the SoftWindows for
UNIX Administrator’s
Guide.

Non-System disk or disk
error

SoftWindows is attempting
to boot from an MS-DOS
floppy disk in drive A:
which has not been
initialized as a startup disk.

Eject the floppy disk from
drive A:.
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SoftWindows VFSA errors

These errors appear in the SoftWindows window and relate to the use of VFSA drives:

Table 6-4 VFSA-Related Errors in the SoftWindows Window

Error Explanation Suggestion

The host filesystem directory
cannot be found

The VFSA directory cannot
be found.

Verify that the UNIX
directory has not been
renamed, moved, or deleted.

The host filesystem name
must be a directory

An VFSA drive has been
given the name of a UNIX
file.

Only UNIX directories can
be specified for VFSA drives.

The host filesystem must
have read access

The VFSA directory cannot
be read.

Change the UNIX
directory’s access
permissions.

The x drive is not being used You are trying to detach a
drive with NET USE /D
which is not attached.

Check the NET USE
command argument for
drives currently attached.

The x drive is not a network
drive

You are trying to attach a
non-network drive which is
already in use, for example,
drive C:, with a NET USE
command.

Retry the NET USE
command with the correct
drive id.

The x drive is already in use You are trying to attach a
network drive (id of E
onwards) with a NET USE
command, but the drive is
already in use.

Retry the NET USE
command with the correct
drive id.

Illegal drive specification The drive letter specified in
an FSADRIVE or NET USE
command is not valid.

Check that it is a single letter
followed by a colon, in the
range E to LASTDRIVE.
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SoftWindows errors

Errors reported by SoftWindows are numbered, and appear in an error dialog box.

For details of these errors, refer to the SoftWindows 95 for UNIX Administrator’s Guide.

Networking errors

By default, networking errors are not displayed in an error dialog box. However, if you
are encountering networking problems, you can enable error reporting in one of the
following two ways:

Command-line option

To enable network error reporting from the command line include the command-line
option -snerror when running SoftWindows.

Environment variable

Alternatively, networking error reporting can be enabled by setting the SNERROR
environment variable to one of the following values:

• SNERROR X - Network errors are displayed in an error dialog box.

• SNERROR console - Network errors are output to the system console.
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Troubleshooting TCP/IP

Other PCs in your Network Neighborhood aren’t displayed

If you can't see any other PCs in your Network Neighborhood, there are several reasons
why it might not be working:

• The Silicon Graphics system is not properly connected to the network. A quick test
is to ping the Silicon Graphics system’s IP address from a known working PC or
Workstation.

• You have not chosen a common Protocol. Right click the Network Neighborhood
icon and choose Properties from the drop down menu, verify that the protocol used
on your PC network is listed (most likely NetBEUI), if not add it and check the
Properties.

• You did not follow all the instructions in the section “Configuring SoftWindows 4.0
for networking to other PC network clients” in the SoftWindows 95 for UNIX
Administrator’s Guide.

The ping or ftp commands don’t work

If you can’t get the ping or ftp commands to work in SoftWindows:

SoftWindows uses an optimized TCP/IP stack. To use the ping command, the Microsoft
stack will have to replace SoftWindows’ stack. To do this, follow these steps:

1. To overwrite the SoftWindows Winsock dlls you first need to *extract* the Microsoft
dlls from the Win95 CAB files. From a DOS prompt run

extract /a /l c:\ win95_02.cab winsock.dll

and

extract /a /l c:\ win95_02.cab wsock32.dll

These will search and extract the required files from whichever cab file (in the
current directory) exist, placing the extracted files in the root directory of Drive C.

2. Copy the new wsock32.dll into the C:\WINDOWS\SYSTEM directory and
winsock.dll into c:\WINDOWS. (Remember that the SoftWindows dlls are still
available in the C:\INSIGNIA directory if you need to get them back.)
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You must use a unique IP address when you have an full TCP/IP protocol stack within
SoftWindows (be that DOS, Windows, or Windows95). The IP Address assigned is that
on the IRIX host. SoftWindows should be given a unique IP Address.

If Microsoft TCP/IP has been installed then the winsocks being used are Microsoft's, not
SoftWindows’. The Microsoft INF file is patched to extract the Microsoft Winsock and
WSOCK32.dll files during TCP/IP installation. To use telnet, ftp or ping, you must install
Microsoft TCP/IP and manually switch winsocks.

Note: This is different than the ODI driver in version 1.01. Telnet and ftp were able to
work without switching the Winsocks.

An alternative to using ping for network testing is to use telnet. (Remember to use the
desired system’s IP address—not the host name—if you have not modified SoftWindows
hosts file.) telnet does not require the above DLL replacement.

See Table 6-5 for a chart of the various configuration combinations that work for these
commands when running SoftWindows.

Table 6-5 Valid ftp, telnet and ping Configurations

Configuration/Test Microsoft ping Microsoft telnet Microsoft ftp Notes

No networking installed (default) Invalid
configuration

WORKS Invalid
configuration

SoftWindows Winsocks
(default). No Microsoft
Protocol stack.

Install Microsoft TCP/IP WORKS WORKS WORKS Microsoft Winsocks and
Protocol stack

to SoftWindows localhost (itself) WORKS not a possible
operation

not a possible
operation

Microsoft Winsocks and
Protocol stack

to my IRIX localhost Invalid
configuration

Invalid
configuration

Invalid
configuration

IRIX snoop doesn't
support this

to another IRIX in subnet WORKS WORKS WORKS
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Get a Page Fault and Microsoft Exchange windows look strange

If you get a Page Fault and the windows look strange when you run Microsoft Exchange:

1. Issue the following command:

setenv FOLDED_ENTER_LEAVE_OPT FALSE

2. Launch Softwindows.

An alternative is to create a launch script that performs the above command and then
launches SoftWindows.

Troubleshooting ODI

Link Support Layer

No problems should be encountered when loading the Link Support Layer. If an error
does occur, the most likely cause is an incorrect entry in the LINK SUPPORT section of
the NET.CFG file.

The ODI driver

Several problems could cause the SoftWindows ODI driver to report a failure at load
time. The following are common faults and solutions:

• ODI driver cannot find the host’s network adapter

The message shown below indicates that the Softwindows ODI driver has failed to
initialize or find the host’s network device:

C:\NWCLIENT>etherspc
Insignia Ethernet MLID  v2.00E (950908).
(C) Copyright 1991-1995 Insignia Solutions Inc. All Rights Reserved.
IRQ 10, Node Address 800690895E2 L
Max Frame 1514 bytes, Line Speed 10 Mbps, Bus ID 0
Board 1, Frame ETHERNET_802.2, LSB Mode
Board 2, Frame ETHERNET_II, LSB Mode
Board 3, Frame ETHERNET_SNAP, LSB Mode
Board 4, Frame ETHERNET_802.3, LSB Mode
Could not find a host Ethernet card.
ETHERSPC-DOS-6: The adapter did not initialize. ETHERSPC did not
load.
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The SoftWindows ODI driver has failed to initialize or find the host’s network
device. Ensure that:

• The specified topology (Ethernet/Token-Ring) is supported on your platform.

• The SoftWindows executable is owned by root, group sys, and has the ‘s’ bit set.

• ODI driver is loaded twice

The second attempt at loading the ODI driver will produce error output similar to
the following:

C:\NWCLIENT>etherspc
Insignia Ethernet MLID  v2.00E (950908).
C) Copyright 1991-1995 Insignia Solutions Inc. All Rights Reserved.
ETHERSPC-DOS-7: You need another ETHERSPC driver section in the
NET.CFG file in order to load the LAN driver again.

The SoftWindows ODI drivers can only be loaded once. If you need to reload the
ODI driver simply unload the previous instance first with the command:

ETHERSPC U
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Application icon

In Windows, a graphic icon that represents a running application. This icon appears only
after you start an application and reduce (minimize) it.

Application window

In Windows, the window containing the work area and menu bar for an application. The
name of the application appears at the top of the window.

AUTOEXEC.BAT

A special batch file that is executed each time the PC boots up.

Batch file

A text file, identified by a .BAT extension, containing MS-DOS commands. When the file
is run, the commands it contains are executed in sequential order as if they were typed
at the keyboard.

Boot

The PC terminology for starting up the computer.

CD-ROM

A read-only form of data storage, using standard Compact Disc media, capable of
providing over 600 Mbytes of data.

Client

A system on a network that uses services held on other remote systems. See also Server.

Communication port

The name given to the interface which can be used to connect a modem. This is also
known as the serial communication port.
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COM1 to COM4

The names of the serial communication ports supported by MS-DOS.

Configuration file

A file containing information to determine which printers, disk drives, and other devices
will be available to you when you run SoftWindows.

CONFIG.SYS

A special MS-DOS text file that contains commands to configure the MS-DOS operating
system.

Control menu box

An application running in Windows has a control menu box at the top left of the
application window. This allows you to control the characteristics of the window and
switch between applications.

Copy protection

A routine embedded in commercial software that prevents users from making
unauthorized copies.

Current directory

The directory in which MS-DOS looks for files.

Current drive

The drive on which MS-DOS looks for a directory or a file.

Device

A piece of hardware, such as a printer, that performs a specific task.

Device name

The name used to refer to a device; for example, LPT1: and LPT2: are used to refer to
printers.

Directory

A division or level in an hierarchical file storage system that can include files and other
directories.
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Drive letter

The letter used to identify a drive; such as A:, B:, C: to Z:.

Emulated hard drive

A file located in your UNIX file system which has an MS-DOS file system layout. This
allows it to emulate and function like a PC hard drive. In SoftWindows, drives C: and D:
are emulated hard drives.

Ethernet

A widely used network system and communications method standardized by the IEEE
802.3 committee and by ISO.

Ethernet_802.2, _II,_SNAP, and _802.3

The alternative standards that can be used on an Ethernet cabling system.

Extended memory

The XMS (Extended Memory System) standard for increasing the amount of memory
available to PC applications using the protected mode available on 80286, 80386, and
80486 computers.

Extension

The last part of an MS-DOS filename, which can be used to specify the type of file. It
consists of a period and up to three letters; such as .BAT.

File

A collection of data stored on a hard disk, floppy disk, tape, or CD-ROM under a single
name.

File permissions

See Permissions.

Frame

A unit of information that is transmitted over the network. It is also referred to as a
message packet. Your frame structure can differ depending on the frame type in use. You
should ensure that your computer is configured for the appropriate frame type.
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Frame type

A variation of a protocol, defining the internal structure of a packet. There are several
frame types supported by SoftNode. When setting up SoftNode you need to choose the
correct one for your network.

VFSA

Virtual File Sharing Architecture.

VFSA drive

A name for a drive that is treated by the PC as being on a different computer. VFSA drives
cannot be formatted or partitioned. SoftWindows allows you to set up UNIX directories
as VFSA drives.

Group

A collection of applications, accessories, or documents within the Windows Program
Manager.

Home directory

Your default UNIX directory; that is, the one you use for storing personal work, files
associated with your user account, and other directories.

Host

A program that supplies services to other computers across a network.

IEEE (or ISO) 802.3

A standard developed for Ethernet networks, defining the physical cabling and software
protocols. See Frame type.

Internet

An internet is an interconnected group of networks. When written as Internet it refers
specifically to the DARPA Internet.

IPX

One of Novell’s communication protocols, Inter-network Packet eXchange. It addresses
and routes outgoing data packets across the network. IPX is a connectionless protocol.
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ISO 9660 standard

The official term for the High Sierra standard format for
CD-ROMs.

Local Area Network

A Local Area Network (or LAN) consists of computers and shared devices connected to
a single network transmission cable in a limited area, usually a single building or section
of a building.

Microsoft mouse

A popular type of a hand-held pointing tool that can be used with MS-DOS applications
in a SoftWindows window. SoftWindows provides you with emulated support for the
Microsoft Mouse.

Modem

A device that enables a machine or terminal to establish a connection and transfer data
through telephone lines. The name derives from the techniques it uses: modulation and
demodulation.

MS-DOS

Microsoft Disk Operating System; the system software and filing system used on IBM PC
or compatible computers.

NDIS

Network Driver Interface Specification, a standard defined by Microsoft and 3Com. It is
the media- and protocol-independent driver standard used by network operating
systems such as LAN Manager.

NET.CFG

The configuration file used by all ODI drivers and protocols.

NetWare

Novell’s operating system that runs on file servers and routers. It controls system
resources and information processing on an entire network or internetwork.
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NET USE

A command used to set up UNIX directories as PC drives in SoftWindows.

ODI

Novell’s Open Data-Link Interface. It supports media- and protocol-independent
communications by providing a standard interface that allows multiple protocols to
share a single network board without conflict. SoftNode includes ODI drivers for
Ethernet.

Packet

A unit of information that has been formatted for transmission on a network. A packet
contains not only data but also its destination, source, and any routing information it has
collected during its transmission over a network.

Path

A sequence of directory names, separated by a backslash in MS-DOS (\) or a forward
slash in UNIX (/).

PC

An abbreviation for a personal computer such as an IBM Personal Computer or
compatible.

Permissions

The name given to settings that are assigned to each file and directory to determine
which users have access to read, write, or execute its contents.

Port

The name for a serial or parallel interface on a PC. Referred to as COM or LPT ports,
respectively, by MS-DOS.

PostScript

The name of a page-description language designed by Adobe for producing typefaces
and graphics on different printers. Applications use the PostScript language to describe
to printers how graphics and type should appear.
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Printer

A device that prints data and text on paper. A local printer is the printer attached directly
to your computer or workstation. A remote printer is accessed across the network.

Printer queue

A temporary queue of jobs or files in MS-DOS waiting to be printed on a particular
printer.

Prompt

A request, displayed by the computer, that asks you to provide some information or
perform an action; for example, the MS-DOS prompt is usually C:\>.

Protocol

A set of procedural rules that permits the orderly exchange of information. These rules
govern the content, format, timing, sequencing, and error control of the messages being
exchanged.

Read permission

A file setting that allows you, members of your group, or other users to read a file.

Reboot

A procedure that restarts a computer or SoftWindows.

Root

The name of the user who can access all files without restriction. The system
administrator always has root access.

Root directory

The highest level directory in the hierarchical filing system. The root directory is
represented as / in UNIX and as \ in MS-DOS.

Serial port

The communications port, labeled COM1: to COM4:, to which you can attach a device
such as a modem.
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Server

A system on a network that provides resources such as disks and printers to other
systems. See also Client.

SNAP

Sub Network Access Protocol frame type. They are extensions of the basic 802.3 and 802.2
frame types, allowing more addressing flexibility.

SPX

One of Novell’s communication protocols, standing for Sequential Packet eXchange. It
creates, maintains, and terminates the connection between network devices (such as file
servers and routers). SPX is a connection-oriented protocol.

SVGA

Super Video Graphics Array, an extension of VGA.

$SWINHOME

An environment variable that points to the UNIX directory containing SoftWindows; for
example, /usr/SoftWindows.

SYSTEM.INI

A Windows initialization file that provides information about the MS-DOS environment.

System administrator

The person in charge of performing administrative tasks on a system.

TCP/IP

Transmission Control Protocol/Internet Protocol. A widely used industry standard for
connecting different types of computers. An internet is an interconnected set of
networks.

Text editor

An application used to create or change text files. The standard MS-DOS text editor is
referred to as EDIT.
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Text file

Data contained in a file that you can read because it contains ordinary letters, numbers,
and punctuation marks.

VGA

Video Graphics Array; the most widely accepted standard for PC graphics displays.

Volume

An alternative name for a hard drive.

Windows

A Microsoft user interface for PCs, which provides windows, icons, menus, and mouse
control.

WIN.INI

A Windows initialization file that allows you to customize your Windows environment.

Winsock

A PC network interface for TCP/IP applications.

Write enabling

A method of allowing data to be written to a disk.

Write protection

A method of preventing new data from being written to a disk and preventing any
existing data from being overwritten.





Tell Us About This Manual

As a user of Silicon Graphics products, you can help us to better understand your needs
and to improve the quality of our documentation.

Any information that you provide will be useful. Here is a list of suggested topics:

• General impression of the document

• Omission of material that you expected to find

• Technical errors

• Relevance of the material to the job you had to do

• Quality of the printing and binding

Please send the title and part number of the document with your comments. The part
number for this document is 007-3113-007.

Thank you!

Three Ways to Reach Us

• To send your comments by electronic mail, use either of these addresses:

– On the Internet: techpubs@sgi.com

– For UUCP mail (through any backbone site): [your_site]!sgi!techpubs

• To fax your comments (or annotated copies of manual pages), use this
fax number: 650-932-0801

• To send your comments by traditional mail, use this address:

Technical Publications
Silicon Graphics, Inc.
2011 North Shoreline Boulevard, M/S 535
Mountain View, California  94043-1389


